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1 Introduction

1.1 Welcome to MacroHTML

MacroHTML is an application that allows you to create static websites very easily. It does this by
helping you in several ways:

· generates html from easily readable text
· allows you to define (and maintain) repeating sections of pages just once
· link checker - makes sure that you have no missing links in your site
· sitemap creator
· manages the files in your project in an easy to navigate manner

As a programmer, I found creating and looking after my website a tiring and tedious job - one that I'd
usually avoid if possible. What I wanted was something that combined the ease of c/c++ '#include files'
(for those repeating sections of the pages such as the header or footer and some menu items with a
'wiki' like syntax.

I wanted to be able to define a hyperlink just by typing it in: [[www.cnn.com]] rather than all that <a
href...> stuff. To put images in just like this: {{mypicture.jpg}} And to define headings just like this
==Heading==. Of course I needed to be able to use HTML as well, because there was no point in
implementing everything - just those things that I wanted most.

Click here for an example.

What it is not. MacroHTML is not a complex, expensive and sophisticated website generation tool.
Because of this I cannot offer technical support (except for bug fixes) for people using it. However, the
learning curve that it presents should be fairly easy to surmount if you have a reasonable technical
understanding of what it's doing and computers in general.

1.2 Example usage

An example:

<<header.inc>>
==Hello==

This is an un-ordered list of things:

  * Item 1
  * Item 2
  * Item 3

with a right justified picture with an alternate text tag: {{mypicture.jpg|some text
description }} Notice the space at the rightm just before the curly brackets - that
makes the image right aligned.
<<footer.inc>>

Now this could be expanded by Macro HTML's inbuilt pre-processor and compiler to:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd">

<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="en" lang="en">

<head>
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<meta name="Description" content="Bonamy House, Wilson, Soane" />
<meta name="Keywords" content="Wilson, Soane" />
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1" />
<meta name="Distribution" content="Global" />
<meta name="Author" content="James Collings jamie at cgisys dot net" />
<meta name="Robots" content="index,follow" />

<link rel="stylesheet" href="images/PixelGreen.css" type="text/css" />

<title>Bonamy House, Guernsey</title>

</head>

<body>
<!-- wrap starts here -->
<div id="wrap"><p> <div id="header"><div id="header-content">

<h1 id="logo">Bonamy <span class="gray">House</span></h1>
<h2 id="slogan">Guernsey</h2>

<!-- Menu Tabs -->
<ul>

<li><a href="index.html" id="current">Home</a></li>
<li><a href="renovation/index.html">Renovation</a></li>
<li><a href="index.html">Downloads</a></li>
<li><a href="index.html">Support</a></li>
<li><a href="index.html">About</a></li>

</ul>

</div></div>

<div class="headerphoto"></div>

<!-- content-wrap starts here -->
<div id="content-wrap"><div id="content">

<div id="sidebar" >
</p> <div class="sidebox">

<h1>Restoration tricks</h1>

<p>Epoxy beam splicing</p>
<p>Industrial paints</p>
<p>Stucco</p>
<p><A HREF="boilers.html">Heating</A></p>
<p><A HREF="http://www.cgisys.com/macrohtml.html">Site

generator (mine :-))</A></p>
</div>

</div>

<div id="main">

<div class="post">
<h1>Hello</h1><p>This is an un-ordered list of things:</p>
 <ul><li>Item 1</li> <li>Item 2</li> <li>Item 3</li></ul>with a right justified
picture with an alternate text tag: <IMG SRC="mypicture.jpg" ALT="some text
description"ALIGN=RIGHT> Notice the space at the rightm just before the curly
brackets - that makes the image right aligned.

</div>

</div>

<!-- content-wrap ends here -->
</div></div><p><!-- footer starts here -->



Introduction 4

© 2007 European Commercial Consortium Ltd.

<div id="footer"><div id="footer-content">
</p> <div class="col float-left">

<h1>Products we used</h1>
 <ul><li><A HREF="http://www.sindat.cz">Sindat paints</A></li> <li><A
HREF="http://www.keimpaints.co.uk">Keim paints</A></li> <li><A
HREF="boilers.html">Protherm boilers</A></li>

</ul> </div>
<div class="col float-left">

<h1>Architecture</h1>
 <ul><li><A HREF="http://www.soane.org/">Soane museum</A></li> <li><A
HREF="http://www.stjames.gg/">St. James the Less</A></li> <li><A
HREF="http://www.themarketplace.gg/h_architecture.html">Markets</A></li> <li><A
HREF="http://www.museum.guernsey.net/download/Elizabeth_College.pdf">Elizabeth
College</A></li>  </ul> </div>

<div class="col2 float-right">
<h1>Other</h1>

&copy; copyright 2007 <strong>James Collings</strong><br />
Design by: <a href="index.html"><strong>styleshout</strong></a> &nbsp;

&nbsp;
</div>

</div></div>
<!-- footer ends here -->

<!-- wrap ends here -->
</div><p></p></body>
</html>

So. What's easier to edit and maintain? The raw HTML that is directly above, or MacroHTML's
simple syntax, right at the start?

Oh, and here's the finished page:
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Notice the central area:

This was the text between the <<header.inc>> and <<footer.inc> include directives:

==Hello==

This is an un-ordered list of things:

  * Item 1
  * Item 2
  * Item 3

with a right justified picture with an alternate text tag: {{mypicture.jpg|some text
description }} Notice the space at the rightm just before the curly brackets - that
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makes the image right aligned.

You may notice that the image 'mypicture.jpg' is missing (bottom right) and that the browser is
displaying the 'alt text' 'some text description' that was defined in the image link in the sample snippet.

Of course, this example also relies on a sophisticated stylesheet to make everything look good, and I
used one of the ones at styleshout.com.

1.3 Installation

MacroHTML requires few resources on your computer; that means that it'll run on most machines.

Installation steps are:

1. Login to your computer as an administrator so that you can install software.
2. Download the software from our site: http://www.cgisys.com/macro_html/MHSetup.exe
3. Check it for viruses etc. just as you would any other software. Your virus scanner should do this

for you automatically.
4. Open the downloaded file & you'll get the MacroHTML installer.
5. Press <Next>
6. Select 'I accept the agreement' if you wish to do so and press <Next>
7. Press <Next> to accept the default installation path if you wish, or change it.
8. Press <Next> to accept the program shortcut location
9. Check 'Create desktop Icon' if you want one (not required)
10. Press <Install> to finally install the software.
11. Do read the short post install message. It tells you that there is a sample website that has been

installed for you to play with in c:\samplesite
12. Press <Next>
13. Press <Finish>

1.4 License

This version MacroHTML is licensed under the Creative Commons 3.0 license which can be found at:

http://creativecommons.org/licenses/by-nd/3.0/

You may use this software to produce websites, but you must retain the link back to us that it
generates on the websites produced. If you do not want this link, then you can purchase a serial key
that allows you to disable this link feature from MacroHTML for a nominal fee.

The serial key is not licensed under the above agreement and you are expressly prohibited
from distributing it.

Abreviated form:

You are free:

    * to Share — to copy, distribute and transmit the work

Under the following conditions:

    *

      Attribution. You must attribute the work in the manner specified by the author or licensor (but not in
any way that suggests that they endorse you or your use of the work).

http://www.cgisys.com/macro_html/MHSetup.exe
http://creativecommons.org/licenses/by-nd/3.0/
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    *

      No Derivative Works. You may not alter, transform, or build upon this work.
    *
    * For any reuse or distribution, you must make clear to others the license terms of this work. The
best way to do this is with a link to this web page.
    * Any of the above conditions can be waived if you get permission from the copyright holder.
    * Nothing in this license impairs or restricts the author's moral rights.

Disclaimer disclaimer

Your fair dealing and other rights are in no way affected by the above.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CREATIVE
COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS PROTECTED BY
COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS
AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO
BE BOUND BY THE TERMS OF THIS LICENSE. TO THE EXTENT THIS LICENSE MAY BE
CONSIDERED TO BE A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED
HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

   1. "Adaptation" means a work based upon the Work, or upon the Work and other pre-existing works,
such as a translation, adaptation, derivative work, arrangement of music or other alterations of a
literary or artistic work, or phonogram or performance and includes cinematographic adaptations or
any other form in which the Work may be recast, transformed, or adapted including in any form
recognizably derived from the original, except that a work that constitutes a Collection will not be
considered an Adaptation for the purpose of this License. For the avoidance of doubt, where the Work
is a musical work, performance or phonogram, the synchronization of the Work in timed-relation with a
moving image ("synching") will be considered an Adaptation for the purpose of this License.
   2. "Collection" means a collection of literary or artistic works, such as encyclopedias and anthologies,
or performances, phonograms or broadcasts, or other works or subject matter other than works listed
in Section 1(f) below, which, by reason of the selection and arrangement of their contents, constitute
intellectual creations, in which the Work is included in its entirety in unmodified form along with one or
more other contributions, each constituting separate and independent works in themselves, which
together are assembled into a collective whole. A work that constitutes a Collection will not be
considered an Adaptation (as defined above) for the purposes of this License.
   3. "Distribute" means to make available to the public the original and copies of the Work through sale
or other transfer of ownership.
   4. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work under the
terms of this License.
   5. "Original Author" means, in the case of a literary or artistic work, the individual, individuals, entity or
entities who created the Work or if no individual or entity can be identified, the publisher; and in
addition (i) in the case of a performance the actors, singers, musicians, dancers, and other persons
who act, sing, deliver, declaim, play in, interpret or otherwise perform literary or artistic works or
expressions of folklore; (ii) in the case of a phonogram the producer being the person or legal entity
who first fixes the sounds of a performance or other sounds; and, (iii) in the case of broadcasts, the
organization that transmits the broadcast.
   6. "Work" means the literary and/or artistic work offered under the terms of this License including
without limitation any production in the literary, scientific and artistic domain, whatever may be the
mode or form of its expression including digital form, such as a book, pamphlet and other writing; a
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lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a
choreographic work or entertainment in dumb show; a musical composition with or without words; a
cinematographic work to which are assimilated works expressed by a process analogous to
cinematography; a work of drawing, painting, architecture, sculpture, engraving or lithography; a
photographic work to which are assimilated works expressed by a process analogous to photography;
a work of applied art; an illustration, map, plan, sketch or three-dimensional work relative to geography,
topography, architecture or science; a performance; a broadcast; a phonogram; a compilation of data
to the extent it is protected as a copyrightable work; or a work performed by a variety or circus
performer to the extent it is not otherwise considered a literary or artistic work.
   7. "You" means an individual or entity exercising rights under this License who has not previously
violated the terms of this License with respect to the Work, or who has received express permission
from the Licensor to exercise rights under this License despite a previous violation.
   8. "Publicly Perform" means to perform public recitations of the Work and to communicate to the
public those public recitations, by any means or process, including by wire or wireless means or public
digital performances; to make available to the public Works in such a way that members of the public
may access these Works from a place and at a place individually chosen by them; to perform the Work
to the public by any means or process and the communication to the public of the performances of the
Work, including by public digital performance; to broadcast and rebroadcast the Work by any means
including signs, sounds or images.
   9. "Reproduce" means to make copies of the Work by any means including without limitation by
sound or visual recordings and the right of fixation and reproducing fixations of the Work, including
storage of a protected performance or phonogram in digital form or other electronic medium.

2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any uses free from
copyright or rights arising from limitations or exceptions that are provided for in connection with the
copyright protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants You a
worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright) license to
exercise the rights in the Work as stated below:

   1. to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce
the Work as incorporated in the Collections; and,
   2. to Distribute and Publicly Perform the Work including as incorporated in Collections.
   3.

      For the avoidance of doubt:
         1. Non-waivable Compulsory License Schemes. In those jurisdictions in which the right to collect
royalties through any statutory or compulsory licensing scheme cannot be waived, the Licensor
reserves the exclusive right to collect such royalties for any exercise by You of the rights granted under
this License;
         2. Waivable Compulsory License Schemes. In those jurisdictions in which the right to collect
royalties through any statutory or compulsory licensing scheme can be waived, the Licensor waives the
exclusive right to collect such royalties for any exercise by You of the rights granted under this License;
and,
         3. Voluntary License Schemes. The Licensor waives the right to collect royalties, whether
individually or, in the event that the Licensor is a member of a collecting society that administers
voluntary licensing schemes, via that society, from any exercise by You of the rights granted under this
License.

The above rights may be exercised in all media and formats whether now known or hereafter devised.
The above rights include the right to make such modifications as are technically necessary to exercise
the rights in other media and formats, but otherwise you have no rights to make Adaptations. Subject
to Section 8(f), all rights not expressly granted by Licensor are hereby reserved.

4. Restrictions. The license granted in Section 3 above is expressly made subject to and limited by the
following restrictions:
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   1. You may Distribute or Publicly Perform the Work only under the terms of this License. You must
include a copy of, or the Uniform Resource Identifier (URI) for, this License with every copy of the
Work You Distribute or Publicly Perform. You may not offer or impose any terms on the Work that
restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted
to that recipient under the terms of the License. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties with every copy of the
Work You Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You may
not impose any effective technological measures on the Work that restrict the ability of a recipient of
the Work from You to exercise the rights granted to that recipient under the terms of the License. This
Section 4(a) applies to the Work as incorporated in a Collection, but this does not require the
Collection apart from the Work itself to be made subject to the terms of this License. If You create a
Collection, upon notice from any Licensor You must, to the extent practicable, remove from the
Collection any credit as required by Section 4(b), as requested.
   2. If You Distribute, or Publicly Perform the Work or Collections, You must, unless a request has
been made pursuant to Section 4(a), keep intact all copyright notices for the Work and provide,
reasonable to the medium or means You are utilizing: (i) the name of the Original Author (or
pseudonym, if applicable) if supplied, and/or if the Original Author and/or Licensor designate another
party or parties (e.g., a sponsor institute, publishing entity, journal) for attribution ("Attribution Parties")
in Licensor's copyright notice, terms of service or by other reasonable means, the name of such party
or parties; (ii) the title of the Work if supplied; (iii) to the extent reasonably practicable, the URI, if any,
that Licensor specifies to be associated with the Work, unless such URI does not refer to the copyright
notice or licensing information for the Work. The credit required by this Section 4(b) may be
implemented in any reasonable manner; provided, however, that in the case of a Collection, at a
minimum such credit will appear, if a credit for all contributing authors of the Collection appears, then
as part of these credits and in a manner at least as prominent as the credits for the other contributing
authors. For the avoidance of doubt, You may only use the credit required by this Section for the
purpose of attribution in the manner set out above and, by exercising Your rights under this License,
You may not implicitly or explicitly assert or imply any connection with, sponsorship or endorsement by
the Original Author, Licensor and/or Attribution Parties, as appropriate, of You or Your use of the Work,
without the separate, express prior written permission of the Original Author, Licensor and/or
Attribution Parties.
   3. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted by
applicable law, if You Reproduce, Distribute or Publicly Perform the Work either by itself or as part of
any Collections, You must not distort, mutilate, modify or take other derogatory action in relation to the
Work which would be prejudicial to the Original Author's honor or reputation.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING, LICENSOR
OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY
KIND CONCERNING THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE,
INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTIBILITY, FITNESS FOR
A PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER
DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT
DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO
EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY FOR ANY SPECIAL,
INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING OUT OF THIS
LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

7. Termination

   1. This License and the rights granted hereunder will terminate automatically upon any breach by
You of the terms of this License. Individuals or entities who have received Collections from You under
this License, however, will not have their licenses terminated provided such individuals or entities
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remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination
of this License.
   2. Subject to the above terms and conditions, the license granted here is perpetual (for the duration
of the applicable copyright in the Work). Notwithstanding the above, Licensor reserves the right to
release the Work under different license terms or to stop distributing the Work at any time; provided,
however that any such election will not serve to withdraw this License (or any other license that has
been, or is required to be, granted under the terms of this License), and this License will continue in full
force and effect unless terminated as stated above.

8. Miscellaneous

   1. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers to the
recipient a license to the Work on the same terms and conditions as the license granted to You under
this License.
   2. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect
the validity or enforceability of the remainder of the terms of this License, and without further action by
the parties to this agreement, such provision shall be reformed to the minimum extent necessary to
make such provision valid and enforceable.
   3. No term or provision of this License shall be deemed waived and no breach consented to unless
such waiver or consent shall be in writing and signed by the party to be charged with such waiver or
consent.
   4. This License constitutes the entire agreement between the parties with respect to the Work
licensed here. There are no understandings, agreements or representations with respect to the Work
not specified here. Licensor shall not be bound by any additional provisions that may appear in any
communication from You. This License may not be modified without the mutual written agreement of
the Licensor and You.
   5. The rights granted under, and the subject matter referenced, in this License were drafted utilizing
the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended
on September 28, 1979), the Rome Convention of 1961, the WIPO Copyright Treaty of 1996, the
WIPO Performances and Phonograms Treaty of 1996 and the Universal Copyright Convention (as
revised on July 24, 1971). These rights and subject matter take effect in the relevant jurisdiction in
which the License terms are sought to be enforced according to the corresponding provisions of the
implementation of those treaty provisions in the applicable national law. If the standard suite of rights
granted under applicable copyright law includes additional rights not granted under this License, such
additional rights are deemed to be included in the License; this License is not intended to restrict the
license of any rights under applicable law.

1.5 Registration

MacroHTML is offered as shareware. This means that you are free to try the software prior to
purchasing. In fact you don't have to purchase it at all, because the only restriction that we make is that
an unregistered version always outputs text like this at the bottom of each page:

"HTML generated on 26/12/2007 01:37:00 by MacroHTML from CGI Systems"

This is so that our software gets recognized and we get some small value back from you.

If you do wish to register, you can do so by purchasing a 'serial key' from us. The process is simple

1. Follow the 'purchase' link on our site from this page: http://www.cgisys.com/macrohtml.html
2. You purchase the software for a nominal fee from Shareit!, who are one of the largest software

resellers on the net, so it's safe and secure.
3. They send you an email with a small 'registry' file attached. This is simply a text file with your

registration details in it.
4. You save this file and double click it when logged in with admin rights so that your registry is

http://www.cgisys.com/index.html
http://www.cgisys.com/macrohtml.html
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updated.
5. When you restart MacroHTML, you'll see that the main menu option 'Other|Remove CGISYS link

from compiled footers can now be checked.

That's it. Your registered name is displayed in the about dialog:

In case you're interested, the key file that you install contains text like this:

REGEDIT4

[HKEY_LOCAL_MACHINE\Software\CGISYS\MacroHTML]
"Key"="1234567"
"RegName"="Peter Test Müller"

In other words, there's nothing nasty there :-)

2 Tutorial

2.1 Step 1 - using the example site

MacroHTML comes with a very simple sample site, located in c:\samplesite. You should take a look at
this before creating your own site.

Start MacroHTML
Choose File | Open Project
Select the c:\simplesite\simple.hhj project as displayed below:
.
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Open it.

you will see that MacroHTML now looks like this, with the project loaded:

Click on the 'INDEX.HTML' file in the left hand list - the contents of the file will be displayed in the right
hand editor.
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Press the 'Build All' button. The pseudo HTML file that is displayed in the editor will be converted to real
HTML, which you can view by selecting the 'View' tab of the right hand area or by pressing the
View/Run button.

Switch back to the editor & notice the first line of text: '<<header.inc>>'

This tells MacroHTML to include all the text that is found in the header.inc file at the spot where the
<<header.inc>> directive is located, replacing it.

The next line is: //==MacroHTML==// This tells MacroHTML to start italics ('//'') to start 'heading 1 style'
('==') and to output the text until those sybbols are found again, at which point MacroHTML will close
the heading 1 and italic tags in the final HTMLText.

Click on the 'View' tab to see the final HTML in a 'rendered' form. Click on the 'Generated source'  to
see it as raw HTML.

Click back on to the 'Edit' tab. After the line '//==MacroHTML==//', add something like 'My added text'
followed by a new line. Notice tha tthe 'Save' button to the left of the toolbar is enabled whenever you
change any text in the editor. Press 'Save' & 'Build'.

Change back to the 'View' tab. The text that you have added has been added to the final compiled
HTML page.

If you check what's in the c:\samplesite directory, you'll see the following:
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These are the files that you are editing in MacroHTML.

Now check the c:\samplesite\output directory. These are the files that MacroHTML makes for you
when you press the 'Build' or 'Build All' buttons.

And they are the files that comprise your website. MacroHTML does not produce or manipulate
images, so you need to have placed them in the output directory yourself. There are many good image
manipulation programs available on the interenet - such as IrfanView (http://www.irfanview.net/)

Obviously, if you want them to be visible on the net, you'll need to copy them to a webserver. typically
using an FTP program, such as TotalCommander.

Next>>

2.2 Step 2 - editing include files

'Include' files allow you to re-use sections of your website that are repeated on several pages. Instead
of copying text and then maintaining the same text in many pages, you can put all that text in a special
file, and simply put a link to the file in your pages.

The files are called 'template' files, and they have the extension '.inc'. In the sample website, you'll
notice that there are three files:

index.html
header.inc
footer.inc

If you take a look at the text at the top of index.html in the editor, you'll notice the line:

http://www.irfanview.net/
http://www.ghisler.com/
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<<header.inc>>

When MacroHTML encounters this when you build your html file, it replaces this with the text it finds in
'header.inc'. It does the same with the <<footer.inc>> file that is referenced at the bottom of the
page.

In fact MacroHTML does exactly the same process when it reads header.inc - it looks for include
directives (files within << & >> brackets) and substitutes their text in place of the directives. So one
include file can include another, and another etc.

Include files are very useful for menus and can be used for much of the site, except the area where
your contents change on a page by page basis.

For example:

<<header.inc>>
<<menu.inc>>

my specific page based menu options could be here

<<main_page_layout.inc>>

page text page text page text page text page text page text

<<copyright.inc>>
<<footer.inc>>

<<Prev Next>>

2.3 Step 3 - formatting tokens

Another major feature that Macro HTML offers are tokens. They are much more human readable
formatting markers that the compiler turns into fully formed HTML. You can find a full list here.

For example, change the text 'But sites made with MacroHTML...' to '**But sites made with
MacroHTML**...' Press  Save and Build. View the finished page in the 'View' tab. Notice that that text
is now bold. Check out some of the other simple formatting things back in the edit page.

<<Prev Next>>

2.4 Step 4 - adding pages

Let's make a new page for our sample site.

Right click on the file list and select the 'New HTML Page' option: 
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Enter a filename with the html extension, such as: 

Change the text that has been placed in the file from 'Put your HTML here...' to something like this:

Save & build it.

<<Prev Next>>

2.5 Step 5 - checking links

MacroHTML contains a link checker. As you compile a site compiler messages and links that are
discovered are displayed in the two lists in the 'Compiler output' tabbed page:
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To perform a simple link check, select all items in the link list and right click on the list to select the
menu option 'Check Selected Links'.
There's more information here.

<<Prev

3 Operation

3.1 Building files

'Building' a file is the process by which finished HTML files are made by MacroHTML. When you press

the  button, the selected file source file (that is, the file that you have been editing) will be
read from disk, pre-compiled and then compiled, producing the final HTML page.

Pre-compilation. In this phase, the source is analysed and 'include directives' such as
<<header.inc>> cause files (in this case the file 'header.inc') to be recursively loaded by the pre-
compiler, and each expanded out until the result is a fully expanded stream of text, most likely with
pseudo-html structures in it. Checks are made during pre-compilation for inadvertant looping, where
one include file includes another which includes itself, and a waring will be written into the stream if this
happens.

Compilation. This is the second phase, in which pre-defined macros or tokens found in the text
stream are expanded to full HTML. During this phase links are also extracted and link-checking can be
performed later. Both the links and the compiler progress is written to the IDE's 'Compiler progress'
tabbed page:
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The  button performs exactly the same opearation as the Build button except it does so
for all the files in the project.

3.2 The IDE

MacroHTML has a simple integrated development environment (IDE).
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There is a File menu  which allows you to:

· Create a new project
· Open an existing project
· Create a new HTML file within the project
· Create a new template file within the project
· To remove a file (actually just to mark  it so, not really delete it)
· Open a text editor in which you can manually edit 3rd party files and perhaps the project settings

themselves.

The 'Other' menu allows you to
· Increase the font size of various controls (useful for high-res monitors in early hours)
· Decrease them
· Remove the 'Powered by CGISYS' link on generated pages (if you have a valid serial key to do this).

Help menu. There is also context sensitive help (to a degree) for most of the program's areas which
you can access by pressing the F1 key whilst in MacroHTML.

Below the menus is a toolbar with several buttons that perform the main operations of the program.

· The Save  button will be greyed out unless you have made a change to one of the
source files. Its function is to make sure that the copy of the file that is on disk is exactly that which is
being edited, because the compiler compiles the disk versions not the file in memory that is being
edited.

· The Build  button 'builds' the disk based version of the currently selected file.

· The Build All  button does that same, but for all files in the project.

· The View/Run  button displays the built file (that is the selected source file's
generated counterpart) in your default web browser.

Below the toolbar are the main working areas of the program. On the left is the source file list for the
current project:
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note that this list is resizeable by dragging the splitter bar in-between the list and the work area to the
list's right.

The list contains all the files in your project. Use the pop-up menu that you can access by right-clicking
on the source file list:

to
· Create a new HTML File. MacroHTML will ask you for a new file name with this dialog:

 Entera name without path - the file will be stored in
the same directory qas your project file.

· Create a new template file. This is a small file that is included into your html with the <<>> wrappers.
Thes files allow you to create complicated websites with repeating structures such as manus,
headers and footers with great consistency.

· Delete. This only marks the file as deleted in your project. It does not actually delete the file from
disk.

· Refresh. Reloads the list and the project from disk.
· Change file path. This is needed when you move a project or files around.

Then there is the 'main work area' which is subdivided into several tabbed pages:
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Clich here for details of the main work area.

3.3 Main work area

This is MacroHTML's main work area:

It is sub-divided into the following tabbed pages:

· Edit - this is where you edit a pseudo html file.
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· View - use the embeded browser/viwer to see what the page looks like after compilation, or use the
'View / Run' button on the main toolbar.

· Generated source - this is what the compiler has generated for you from your source.
· Compiler progress - gives you an adea of the work the compiler has done for you, and also a list of

links that were found in the page/s.

3.4 Editor

The editor:

Has the following functions/options.

You can type into it to create your pseudo html page. or a template for use as an include file. For
example, the file above will create the following looking html page after compilation:
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All that from such simple text!

It's not magic. The text is:

<<header.inc>>
<<main.inc>>

{{images/ray.jpg}}
{{images/ray_section.jpg}}
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<<footer.inc>>

The first line includes the file 'header.inc' which includes the headers, all the way down to the 'quick
links' menu on the left of the web page. The menu is stored in the 'main.inc' file. Two images are
displayed, followed by the footer stored in 'footer.inc'.

Of course the page uses a stylesheet to obtain formatting and the 'main.inc' file stops at such a place
in the text stream that the images and any other artifacts are introduced in a table on the right of the
page. 'footer.inc' closes that table etc.

Back to the editor. You may cut/paste as expected, and search/replace with the search button on the
editor's toolbar:

Pressing this will give you the search/replace dialog:

Syntax highlighting can be turned on/off with the 'Syntax HL' checkbox, also on the editor's toolbar.

And lastly, you can insert a sitemap into the source by right clicking on the editor and choosing the
'Insert sitemap' menu option:

3.5 View

The embedded view is suitable for simple and correctly formatted html files. Use the

 button to view the html in an external browser such as Firefox.

This is a sample of the embedded viewer rendering a generated file:
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The preview capability built into MacroHTML can view most HTML and stylesheet constructs, but it is
not as sophisticated or forgiving as a full web browser.

3.6 Generated source

MacroHTML has generated HTML code from this file:

<<header.inc>>
<<main.inc>>

{{images/ray.jpg}}
{{images/ray_section.jpg}}

<<footer.inc>>

Which has been pre-processed and compiled to create this HTML stream:
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And that it the final product - an html page created with the simplest input!

3.7 Compiler Progress

As MacroHTML compiles a page (or pages), it does a lot of work for you. Simple descriptions of the
work is displayed in the compiler progress list

Links that are found are displayed in the list to the left. You can find more information about links here.



MacroHTML27

© 2007 European Commercial Consortium Ltd.

3.8 Projects

A project file is simply an ini format file with a .mhj extension. Typically it contains .html or .htm and
.inc files in a directory. You can use the main menu's File|Text Editor menu option to edit this file
directly.

This is a project file:

[MACROHTML PROJECT]
DESCRIPTION=
VERSION=1.0
HTMLDEFAULT=D:\shared\sites\boilers\newfiletext.txt
[PATHS]
ROOT=D:\shared\sites\boilers\
OUTPUT=D:\shared\sites\boilers\output\
[HTMLFILES]
D:\SHARED\SITES\TEST\TUNDISH.HTML=true
D:\SHARED\SITES\BOILERS\BOILERS.HTML=false
D:\SHARED\SITES\TEST\INDEX.HTML=true
D:\SHARED\SITES\BOILERS\MORE_BOILERS.HTML=true
D:\SHARED\SITES\TEST\PHOTOS.HTML=true
D:\SHARED\SITES\BOILERS\SITEMAP.HTML=true
D:\SHARED\SITES\TEST\PRICES.HTML=true
D:\SHARED\SITES\TEST\TECHNICAL.HTML=true
D:\SHARED\SITES\BOILERS\WIRINGDIAGRAMS.HTML=true
D:\SHARED\SITES\TEST\CASCADE.HTML=true
D:\SHARED\SITES\TEST\SPECS.HTML=true
D:\SHARED\SITES\TEST\SERVICE.HTML=true
D:\SHARED\SITES\TEST\ADVANTAGES.HTML=true
D:\SHARED\SITES\BOILERS\TEST.INC=false
D:\SHARED\SITES\TEST\MANUFACTURING.HTML=true
D:\SHARED\SITES\TEST\CONTACT.HTML=true
D:\SHARED\SITES\TEST\DOWNLOADS.HTML=true
D:\SHARED\SITES\TEST\GUARANTEE.HTML=true
D:\SHARED\SITES\TEST\ACCESSORIES.HTML=true
D:\SHARED\SITES\BOILERS\.HTML=false
D:\SHARED\SITES\TEST\MOUNTING.HTML=true
D:\SHARED\SITES\TEST\CONNECTION.HTML=true
D:\SHARED\SITES\TEST\EFFICIENCY.HTML=true
D:\SHARED\SITES\BOILERS\SHIPING.HTML=false
D:\SHARED\SITES\TEST\SHIPPING.HTML=true
[INCLUDEFILES]
D:\SHARED\SITES\BOILERS\TEST.INC=false
D:\SHARED\SITES\TEST\FOOTER.INC=true
D:\SHARED\SITES\TEST\HEADER.INC=true
D:\SHARED\SITES\TEST\TECH.INC=true
D:\SHARED\SITES\TEST\MAIN.INC=true
D:\SHARED\SITES\TEST\DIMENSIONS.INC=true

If you move your project, then you'll need to edit this file. However some of the files'  paths can be

changed w ith the source file list's pop-up menu  Change Path option.

3.9 Include files

MacroHTML allows you to define snippets of HTML and include them in your web pages. This allows
you to have a consistent look and feel on all of your pages, and write sections just once, with one
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change being reflected in many files. It does this by using the double arrow bracket directive, eg.
((include/me)) (substituting normal brackets for arrow ones).
This tells the pre-compiler to include a file directly at that position, replacing the tag include directive
that was there. As the file is being included, it in turn is checked to see whether it, too includes other
files. If it does, then these are also included in a recursive manner unless doing so would create a
circular path (at which point a warning message is placed in the parent file and compilation continues,
but skipping that path).

Finally, the resultant pseudo-HTML stream is passed to the macro-compiler where the tags are
expanded out to real HTML. That text stream is written to disk in an output directory as .html files
which can be read by a browser.

An example:

<<header.inc>>
==Hello==

This is an un-ordered list of things:

  * Item 1
  * Item 2
  * Item 3

with a right justified picture with an alternate text tag: {{mypicture.jpg|some text
description }} Notice the space at the right just before the curly brackets - that
makes the image right aligned.
<<footer.inc>>

<<header.inc>> includes the entire contents of the header.inc file that you (presumably) made earlier.
If header.inc also includes any other include file, then they will also be included recursively. Once you
change header.inc (or any of its parts), the site can be re-generated by pressing the 'Make All' button.

Whenever there is text that is repeated in your html source (even is it's in the same file), consider using
an include file. Then, changes that you make to that one include file will be replicated in all other files
that use it, and this makes for a much more consistent site. Although it is a little more trouble at the
start, I'm sure that you'll soon realize how much grief and stress this single feature can save you. As an
alternative for very short phrases and names, check out the 'hot text' feature.

3.10 Tokens

Here's a brief description of each of the tags that are parsed by MacroHTML's macro-compiler.

They are loosely derived from those used by Wikipedia, as these are in common use.
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Bold is denoted by wrapping text in ** chars. Eg. **Bold** gives Bold

Italic is denoted by wrapping text in // chars. Eg. //Italic// gives Italic

Underline is denoted by wrapping text in __ chars. Eg. __Underline__ gives
Underline

Monospace / quoted text is denoted by wrapping it in '' chars.

Paragraphs are denoted by using 2 or more newline characters in succession.

Headline levels are denoted by wrapping text in 2 or more == chars. Eg. ==headline

level 1== gives Headline Level 1
Links are defined within square brackets. [[www.cnn.com]] would give

www.cnn.com, whereas [[www.cnn.com|CNN News]] would give
CNN News

Images are displayed with the {{ tags. Left aligned {{images/CGI-guarantee.gif
}} (note whitespace to left of filename)

Right aligned {{images/CGI-guarantee.gif }} (note whitespace to right
of filename)

Centre aligned {{ images/CGI-guarantee.gif }} (note whitespace either
side of filename)

And the images can have alternate text (incase they don't display).
Use the format {{images/CGI-guarantee.gif|Alternate text}}
Images as links

Images can be used as links by combining the link and image tag
formats like this: [[autoprintpro.html|{{images/autoprint-small.jpg }}]]

(that gives you a link to autoprintpro.html displayed as an image that is
right aligned)

Lists Unordered lists are created as follows:

    * This is item one ( * This is item one)
    * This is item two ( * This is item two)
    * This is item three ( * This is item three)

List items start with two spaces, followed by a *, then a space, then
the text followed by a newline. Ordered lists are the same, except that
they use the '-' character rather than the '*'. The final list item is
denoted by two or more newlines. List items can also be used in
menus, as links. For example:

    * Autoprint is created with: * [[autoprintpro.html|Autoprint]]
    * MacroHTML is created with: * [[macrohtml.html|//MacroHTML//]]

It is worth noting that the html ul, /ul ol and /ol tags are created by
MacroHTML if they are not found. If they are there, they remain intact.
This is so that styles can be preserved - for example, see the 'Our
software' and 'MacroHTML' lists to the left and the 'Home' 'Downloads'
'FAQ' and 'Contact' menu items at the top of the page of our website.

Linebreaks Use a Wiki like syntax, for example:

This is some text with some linebreaks\\ blabla

Note that the two backslashes are only recognized at the end of a

http://www.cnn.com
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.

3.11 Hot text

HacroHTML supports 'hot text' that are name and value pairs placed at the start of the html page. This
feature allows you to easily make 'placeholders' in your pages that are updated automatically. So, for
example if you had a company name such as 'European Commercial Consortium Limited', you could
just use '_ecc' in your text. When it was compiled, the '_ecc' s would be replaced with the full company
name, everywhere in the output version of the files.

They take the following form:

#name=value

and are separated with a newline. They may include link tokens and are processed after the include
files are expanded The end of the list of these is terminated with two or more newline characters:

Eg:

#zaneta=Mrs. Zaneta Collings
#jamak=Mr. James Collings
#filo=Master Philip Collings
#ourco=[[www.cgisys.com|CGI Systems]]

<<top.inc>>
<meta name="Description" content="EMail client">
...
zaneta, jamak and filo can be reached at ourco.
...

becomes:

...
<meta name="Description" content="EMail client">
...
Mrs. Zaneta Collings, Mr. James Collings and Master Philip Collings can be reached

at <A HREF="http://www.cgisys.com">CGI Systems</A>.
...

Of course you may also place the hot text at the top of an include file that is included at the start of your
html page.

3.12 Compiler

This is the last phase of the HTML generation process. The pre-processed pseudo-HTML is expanded
to full HTML, which is placed in the output directory. This is the code that is displayed in the 'View' tab,
and can be seen as raw HTML in the 'Generated Source' tab.

The also compiler creates two output lists. The first contains the links found in the site, and the second
tells you what the compiler did.
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You can 'make' a file (that is the process of turning your source into a proper html file) by pressing the
'Make' or 'Make All' buttons on the main toolbar. The html that is generated in placed in the output
folder.

3.13 Link checker

After you've compiled your site, select all the links from the compiler's link list and right click with on
that list. Choose 'check selected links' and MacroHTML will check that the pages are there. Those that
are not will be displayed in red.
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The left hand pane above displays links found in a file.

If you right click on one of those links, you'll see the following menu:

Select all, then click 'Check selected links'. The bottom status bar:

 
of the program will tell you if there were any bad ones, and these will be highlit in the link list in red.

Double-clicking on a valid link will display that page in your default browser.

3.14 HTML files

These are the final files that you are creating through the simple syntax language that is described in
the Include files and Tokens sections. HTML can be cumbersome and tedious to maintain, especially
for a site with several pages each with repeating sections, and that's where MacroHTML comes in.

3.15 Output

This is the output directory where the compiler places the generated HTML, and it is this that you can
copy to your site, most likely with FTP.

3.16 Changing a source file's path

MacroHTML stores its component file paths in a project (which is just an 'ini' format file with the '.mhj'
extension). The paths are absolute and not relative - they take the form
'c:\our_projects\project\file.html' rather than 'project\file.html' .
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There are times when you need to change a source file's path in the project. for example if you have
moved the project or renamed its directory. You can either do this the manual way, by directly editing
the project file with a text editor, or by using the source file list's pop-up menu 'change path' option:

If you select this, and you have selected a source file first, you'll see a dialog like this:

In the 'To' field, select the new path for this file. Select the 'Just for xxx' radio button and press the

 button. You will notice that your file reference has changed in the project. If you selected
the 'For all files in this location' radio button. obviously all files references in the project would have
been changed.

3.17 New file default text

If you want to have default text inserted into each new HTML file that you create, change your project
so that MacroHTML knows where that default text is:

[MACROHTML PROJECT]
DESCRIPTION=
VERSION=1.0
HTMLDEFAULT=D:\shared\sites\boilers\newfiletext.txt
[PATHS]

The HTMLDEFAULT is what you need to set. Also create a file at that location with your default text in
it.

After doing this and saving the project file, ensure that you refresh the project from disk inside
MacroHTML.
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